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FOREWORD 

Version 2 3 of the Functional Economic Analysis Model contains seven major 

changes as follows: 

• addition of edit commands that allow users to customize all of the 

embedded charts that the model displays. 

• updates the DoD deflation factors to those appropriate for the 1993 fiscal year 

• adds the option to cancel simulation 

• data sheets can be viewed in both constant and current dollars. 

• data is now entered in constant dollars (verses current/ther. year dollars) and 

the model's default screens are also in constant dollars. 

• allows the user to clear information relating to the third alternative on the 
Summary screens when there are only two alternatives. 

• improvements to printing procedures. 

This version is designed to work with both Microsoft Excel 3.0• and Microsoft 

Excel 4.0•. When saving files, we recommend that you save them in Microsoft Excel 
3.0• to allow for compatibility and transferabilhy to other machines. 

The model is undergoing continual revision and refinement. If you need assistance 

or have suggestions, please feel free to call and leave a message: 

Feam Hotline: 
Telephone: (703) 845-6780 

iii 
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I. GETTING STARTED 

This section describes how to install the model, how to enter data into the model, 

and introduces the user to the model by briefly discussing how data is entered, analyzed, 

and displayed. 

A. INTRODUCTION 

The Functional Economic Analysis Model (FEAM) is intended to support analyses 

of potential cost-saving alternatives for Department of Defense (DoD) information 

management, and to aid functional managers in presenting their "business case."1 The 

model is designed to allow the user to enter costs and receive information for a series of 

alternatives to a cost baseline. The baseline represents expected costs for a given function 

using existing processes to satisfy projected workload. A DMRD Base represents pre- 

Defense Management Review (DMR) Expenditures and force-reduction levels; it is 

needed only for DoD level FEAs. The model takes the user-supplied information and 

performs a Risk-Adjusted, Discounted Cash Flow (RADCF) analysis for each alternative 

The results are presented in a series of graphs and tables.3 

The remainder of this section gives a brief overview of how to start and use the 

model. The rest of the manual consists of detailed information on the model, including a 

discussion of the form of the cost data needed to run the model. 

Section II guides the user through entering, editing, and analyzing the data. 

Information about discount and inflation rates is presented in this section. 

Section III presents the four types of computer screens that the user will 

encounter. The Summary screen depicts the total costs and savings by function. The 

Alternative screen depicts the savings for a particular alternative The Cost Breakout 

screen depicts costs broken out by major types of expenses. Last, the Data Sheet screen 

serves as the vehicle for the user to input data into the model. 

1-   The user should consult the DoD policy on business case analysis for specific guidance on the scope 
and content of a "basinets case" 

2   This anatysuu based OP chapters > and 9 of Tht Btaimst Vahtt ofCthnptum. Paul A Sttangirann, 
New Canaan, CT: The Information Ecooomics Press, 1990. 



Appendk A deals with the risk adjustment computation carried out by the model 

during the simulation process An outii.ie of cost elements used in the model and the 

definitions of the cost elements are presented in Appendix B Appendix C provles 

detailed instructions on when and how to use the Deflator Conversion program 

The following conventions are used th ougbout this document 

• Menu names and options are denoted in boldface (eg., File menu) 

• Key strokes are denoted by o signs (e.g., <Return> ke> j. 

B. INSTALLING THE MODEL 

The FEAM runs on the IBM PC• and compatibles and the Apple Macintosh• 

The user should be familiar with pull-down menus, dialog boxes, and use of the mouse to 

make selections   The model will require the following: 

Minimum Recommended 

Microsoft Excel 3 0•/4.0•   
A mouse   
2 MB of RAM 4 MB of RAM 
20 MB hard disk 401 IB or higher hard disk 
2.5 MB free space 3.5 MB or more free space 
  Math co-processor 

D3M compatibles 
Microsoft Windows 3 0•/3.1•   
EGA display VGA or higher display 

Macintosh 
Multifinder•   
(Note  do not run FEAM under Finder•) 

To install the model on the IBM PC and compatibles, take the following steps: 

1. Enter Microsoft Windows. 

2. Insert the FEAM disk in drive K or B. 

3. Pull down the File menu and choose the Run• option (Figure 1). 

4. In the command line, type "a:\setup" or "b:\setu_V, depending on whether you 

have placed the disk in drive A or B (Figure 2). The Setup routine wiil lead you 

through installation of the FEAM. 



Figur» 1. choosing Fite/Run 

Figur« 2. Entering the Command Lin« 

For the Apple Macintosh, take the following steps: 

1. Copy the compressed version of the FEAM, labeled TEAM Ver. 2.3 

(Comprfc.\«*d)", from the FEAM disk to your hard duk. 

2. Double-click on the file "FEAM Ver. 2.3 (Compressed)" on your hard disk. 

The installation program will prompt you to select a location for the file, and 

then copy the model to a folder called "FEAM Ver. 2.3." 



Once the model is installed, make sure Excel is not already open and enter the 

model by double clicking on the FEAM icon (PC corupadbles), and the title screen will 

appear, as shown in Figure 3 If yopj wish to open fcxeel first, you may start the FEAM by 

choosing the "buscase xim" (ile from the Open opt'"n of the File menu 

Help 
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C. OVERVIEW OF THE MODEL 

This section briefly iescrib« the use of the model. Figure 4 shows the entire menu 

structure, which is broken into four levels. The levels are described below. 

Level 1 has 10 menus available: File, DMRD Bai* Baseline, Alt A. Alt B, Alt 

C, Simulate, VJ*w, Print, and He'p. The File menu allows you to open l new case, save 

a case, close a case, edit a chart, and eat to either Excel or Windows (Desktop on the 

Macintosh). When you first run the FEAM, two cases are available under Oprn Case. 
"dcmo2 cim" and "inhial2.cim". The file "demo2.cim" is an example case with a 

completed data sheet. The file "initial2.cim" is an blank case template that users can use 

to build business cases. After filling in the data, you can choose the Save Case option to 

save the case. The file name can be only eight characters long. The ".cim" extension 

should not be added, this will be done by the program. Never save a file as "initiate" or 

the blank data sheet will be written over. If you enter a case with only two alternatives (A 

and B) and do not wish to have information displayed for Alternative C, you can save the 



case, close the case, and then reopen it. This procedure will clear all information related to 

Alternative C on the Summary screen for both current-year and constant-year dollars 

However, i; is not necessary to follcv this rocedure - only if you prefer to nave the 

Alternative C information cleared from the viewed charts 

The DMRD Base, Baseline, or one of the three Alternative menus lead you 

through the lower levels where you ein enter or view data and disaggregate! graphs 

Under these menus, you may choose the Ops/Mgmt & Sup Graph option to go to Level 

2, or either the Ops Breakout option or the Mgmt & Sup Breakout option to go 

directly to Level 3   These levels will be discussed later in this section. 

The DMRD Base represents fiuiction costs before any DMR cuts or force level 

reductions The Baseline shows the expected costs of meeting projected workloads using 

the currem processes for the function The Alternatives display the costs of performing 

those projected workloads with improved processes. 
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The Simulate menu allows you to apply the RADCF procedure to any one of the 
three Alternatives You can choose the Edit Parameters option, where the discount rate 
and the number of simulations can be changed One« data have been entered and the 
RADCF simulation has been run, the Summary screen on Level 1 shows a total cost and 
savings graph A table showing undiscounted savings by Alternative is also available by 
using the View menu The View menu also allows you to toggle between current and 

constant dollars ar.d view undiscounted savings by Alterative from both the DMRD Base 

and the Baseline. 

The Print ,uid Help menus are available on every level of the program. The Print 
menu lets you prin: graphs or data sheets available at a particular level The Help menu 

on the first level provides help that will be useful at all levels. Help ai the other levels 

refers specifically to those levels. 

On the first three levels, the user has the option to edit graphs or tables available at 
that level On Level 1, Edit Chart can be found under th*5 File menu. On Levels 2 and 3, 
there is an Edit menu choice. There is no option to edit at the data-entry level (Level 4). 
Selecting Edit allows the user to change the type of graph viewed (bar graph, line graph) 

under the Gallery menu. Also, the user may add a legend, text, arrow, etc. by selecting 

the Chart menu choice. To save an altered graph, the user should select Save As unde. 

the File menu and name the graph as something other than Chart_l.xlc. By doing so, the 

original graphs will still be part of the mode! and the user can access the edited charts 

through Microsoft Excel. It should also be noted that not all types of chart designs will be 
applicable to the graphs at each level. The chart pattern chosen will dictate the extent to 

which the user will have to manipulate the embedded chart's series. 

Level 2 has two purposes: displaying the Operations/Management & Support 

graph and accessing the other levels of data-entry tables The DMRD Base and Baseline 

graphs show total baseline costs broken out by operations and management and support. 

The Alternative graphs display the differences between total operations and total 
management and support costs from the Baseline over time. The Cost Breakout menu 
takes you to the data-entry levels. The Return menu allows you to return to the first 

level. The Edit menu allows you to edit the chart. 

The Level 3 screens show a graphical display of the cost element breakout. The 

Baseline cost element breakout graph represents total cost element spending over time. 

The Operations breakout and Management & Support breakout screens for any of the 

alternatives show the differences in cost dement spending from the Baseline over time. It 



is at this level that you choose a life-cycle phase fcr data entry The menu choices for data 

entry are RDT&E (Research, Development, Test, and Evaluation), Invest (Investmr-.t), 

Op Activities (Operational Activities), Disposal, and Other Another .nenu choice is 

Subtotals which allows you to view the cost element totals No data are entered or 

changed under this choice The Return menu permits you to return to Level 1 or 2 and 

the Edit menu allows you to edit the chart 

Level 4 is where you input data (discu *oJ 'n Section II) For the DMRD Base 

and Base'ine, a single entry is required For the Alternatives, both a high and a low entry 

are required The highs and lows may be the same, or may be zero The Return menu 

allows you to return to Level 1, 2, or 3 



II. MANIPULATING DATA 

This section explains how to enter and edit data, and how to analyze the results 
The model is designed to accept data that is in Constant Dollars. 

A. ENTERING DATA 

The steps for creating a new business case are summarized below. 

• From the title screen of the model, pull down the File menu and »elect the 
Open Case option. 

• Double-click on the file "initial2 cim" A message will appear that suggests 
first-time users choose the Baseline menu item. 

• Pull down the Baseline menu and select the Ops Breakout option. This 
allows you to bypass the Alternative graph level (Level 2) and go directly to 
Level 3, where the life-cycle phase is chosen. 

• Pull down the RDT&E menu hern and select the Data Sheet option. This 
brings you to Level 4 where all cost data are entered. 

Enter the cost data for the RDT&E phase (see Section ÜB for further 
information on entering data). AD cells must contain a number, even if that 
number is zero. 

• Pull down the Return menu and select the Breakout option to get back to 
the life-cycle phase pc ition. 

• Choose another life-cycle phase and enter data as for RDT&E. Repeat foi 
each life-cycle phase. 

• Choose the Summary option from the Return menu. This will take you 
back to Level 1 

• Pull down the Baseline menu and select the Mgmt & Sup Breakout option 
and repeat the steps for entering data for each life-cycle phase. 

• After all data for the Baseline have been entered, puD down the Return 

menu and select the Summary o, .on. 



• Select an Alternative (A, B, or C) and enter data as for the Baseline The 
"high" and "low" entries ;nay be the same (see Section II.B) Room is 
provided for three Alternatives, although only one is needed to run a 
simulation. If you need more than three Alternatives, create a new case. If 

you plan to run many Alternatives on the same Baseline data, make a 

template after entering your Baseline data, and before entering the 

Alternative data. To do this, enter the Baseline data only, and save the Sie 

under a different name (e.g., "basel"). When you open a case, bring up your 
template instead of "initial2.cim". 

• When all the data are entered, pull down the Return menu and select the 
Summary option. You may now run the simulation by choosing one of the 

options under the Simulate menu. 

• To save your work, pull down the File menu and select the Save Case 

option. Enter a file name with no more than 8 characters. Do not enter an 

extension; the extension ".cim" will be automatically attached. All data for 

the Baseline, DMRD Base, and up to three Alternatives can be entered into 

one file. 

B. EDITING DATA 

Once you are in a data sheet, use the arrow keys or the mouse to move the cross 
hairs tc the position to be edited A rectangular box will appear at the position to be 

edited. Type in the desired value and press the <Return> key. If you are using Excel 

4.0• and you wish to place the same value in all the years in a cost dement, the "Fill 

Right" and "Fill Down" key stroke commands can be used. Refer to your Excel manual for 

more information. All values are in millions of constant-year dollars and should be 

rounded to two decimal places. If data is entered with three or more decimal places, the 
program will automatically round them up. Below are definitions for the high and low 

values and what to do when the cost is known with certainty. 

• High - The high estimate represents the cost that is exceeded by the actual cost 
only 2.5 times oui of 100. 

• Low - The low estimate represents the cost that exceeds the actual cost only 

2.5 times out of 100. 

• Certainty- If you know with certainty the cost, then make the high and low 

values the same. 

10 



For the simulation to execute correctly, all cells must contain a non-negative 
numeric value Do not run the simulation with blank cells, enter zeroes where appropriate. 
NOTE The default setting of the model s to display datt in constant dollars Do not input 
data in the Currents xls file The model will not read any data placed in this file by the user 

C. ANALYZING DATA 

Once yoj have entered the data, tht model can analyze the data using the Risk- 

Adjusted, Discounted C«sh Flow (RADCF) analysis. The results are shown as graphs and 
a table. To implement the analysis, choose one of the options under the Simulate menu at 
the top level. Each Alternative must be simulated separately The simulation process 
takes between 50 seconds and 20 minutes on a computer with a math co-processor. 
Without tht math co-processor, it will take much longer. If you wish to discontinue the 
simulation process, you may do so by selecting the cancel button. 

Changes to the discount rate and the number of simulations can be made by 

selecting the Edit Parameters option from the Simulate menu. For final analysis, 500 
simulations are recommuiaed; however, 100 simulations can be used for an intermediate 

analysis Running time for 100 simulations is significantly shorter than for 500 
simulations. 

After selecting the Alternative to simulate, you will be asked for the residual value, 
the expected useful life of the Alternative beyond the six-year planning period 
incorp^tted into the model. To calculate the residual, the model takes the net savings for 

the last year of the planning period (year 6) and computes the present value of the stream 
for the selected number of additional years. 

The RADCF calculation uses the "high" and "low" estimates entered under the 

Alternatives to generate a distribution of possible values for each cost dement. The model 
then estimates the cost for each year in each cost category based on a value from that 

distribution, subtracts it from the correspondhg Baseline, and sums all those values to 
generate a total savings estimate. This process is repeated 500 times. The model then 

reports the average of these estimates to give an expected savings, as well as a "best" and 
"worst" case to give a feel for the distribution of these savings. A complete discussion of 

the simulation methodology is presented in Appendix A. 

11 



.Ml graphs can be viewed in either current o; constant dolbrs Four different 

deflators ,\ie used for converting constant-year dollars into "then" r current-year dollars 

for the eight cost elements as follows 

Cost Elcr ent Deflator 
Civilian labor TOA-Civilian pay 
Military labor *'OA-Total Pay and Allowances 
Information Technology Provided by DDI 
Facilities TOA-Total Non-pay 
Material TOA-Total Non-pay 
Other TOA-Total Non-pay 
General Installation Support TOA-Total Non-pay 
Headquarters Support TOA-Total Non-pay 

The Total Obligationai Authority (TOA) deflators are taken front Table 5-5 of th* 

National Defense Budget Estimates for FY1993 prepared by the DoD Comptroller The 

Director of DoD Information (DDI) has elected to provide a separate rate for the 

Information Technology category because of its unique declining cost behavior in recent 

years. The deflators are as follows: 

Cost Element 1993 1994 1995 1996 1997 1998 
Total Non-pay 1.0000 1.0329 1.0664 1.1009 1.1360 1.1708 
Information Technology 1.0000 0.8800 0.7740 0.6810 0.6000 05280 
Civilian Labor 1.0000 1.0445 1.0936 1.1433 1.1862 1.2325 
Total Pay and Allowances 1.0000 1.0451 1.0934 1.1423 1.1832 1.2281 

The expected RADCF appears on the Summary and Alternative graphs. The 

"best" and "worst" case RADCFs are shown on the Summary graph. Undiscounted 

savings are available under the View menu at Level 1. 
i 

The results may be printed as graphs or tables. A Print menu is found at each 

level, and can be used to print only those tables and graphs displayed at that level. 

12 



III. THE SCREENS 

This section provides a summary of the main screens and their functions Al! the 

graphs require that the data for the DMRD Baseline, Baseline, and at least one Alternative 

be filled in. Furthermore, graphs are updated after each simulation l\as been completed 

A. LEVEL 1 - THE SUMMARY SCREEN 

The Summary screen is viewed from Level 1 and is shown in Figure 5 If you are 

at a different level, Level 1 can be reached by choosing the Summary option from the 

Return menu. 
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Figur» 8. Tb« Summary Screen 

The Summary screen shows the total undiscounted costs associated with the 

DMRD Baseline, Baseline, and each Alternative. There is t Summary screen far current- 

year dollars and a Summary screen for constant-year dollars.  You may toggle between 
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these sheens using the options in the View menu. At ihe bottom of each screen, three 

P.ADCF values for each Alternative are displayed The RADCF represents the cumulative 

present value of cost savings of each Alternative The expected RADCF is the average 

RADCF created by the simulation process, which incorporates risk into the RADCF 

values The high and low RADCFs represent the "best" and "worst" cases, respectively 

For more information on the risk acj'jttment calculation, see Appendix A 

The menu choices at the Summary screen include DMRD Base, Baseline, and the 

three Alternatives, which take you to the Operations/Management & Support breakout 

(Level 2) or the Cost Element breitkout (l^vel 3). Also from this screen, you may open 

and save files, print the Summary graph and undiscounted savings tables for both DMRT» 

Base and Baseline, invoke the simulation routine fo." a particular Alternative, edit the 

Summary graph and the undiscounted savings tables, and exit the model Help at this level 

incluo.es information on commands, cost structure, and cost element descriptions, as well 

as inforrrhiion about the Summary screen. 

There are three options under the pull-down menus for DMRD Base, Baseline, 

and ach Alternative, as shown in Figure 6. The first option, Ops/Mgmt & Sup Graph, 

allows you to display the Baseline total costs, broken out by total operations costs and 

total management and support costs. When this option is selected from one of the 

Alternative menus (Alt A, Alt B, or Alt C), the cost savings are displayed for the selected 

Alternative, broken out by operations and management and support costs. These savings 

represent the generated differences from the Baseline. 

Figur« 6. Choosing a Breakout Scram 

14 



The second option, Ops Breakout, displays total operations costs for the nMRD 

Base or Baseline broken out by major types cf expenses, or, in the case of the 

Ajternatives, the cost savings for operations by major types of expenses. 

The third option, Mgmt & Sup Breakout, minors the Ops Breakout option for 

the management and support side. From the breakout selections, you can sscess the data 

slicets on Level 4 

B. LEVEL 2 - THE OPERATIONS/MANAGEMENT AND SUPPORT SCREEN 

The Level 2 screen displays a combination of two different charts. The Prst is the 

relationship between operations and management and support. This relationship is 

quantified using the left (y) axis. The second chart displays the tooth/tail ratio 'rutio of 

operations to management and support). This relationship is quantified by using the right- 

most (y) axis. By selecting the Opa/Mgmt & Sup Giaph option «rom the Baseline 

menu, a graph similar to Figure 7 is displayed. 

Sa**trt» 

Figui*7. Baaafina Opa/Mgmt * Sup Graph 

At this point you can return to the Summary graph by choosing the Return menu 

and Summary option or break out the costs in more detail. 

If instead you select one of the Alternative menus anJ the Ops/Mgmt & Sup 

Graph option, a graph similar to the one in Figure 8 is displayed. The tooth-to-tail ratio 
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is also displayed on the Alternative screen.   The expected RADCF is displayed a* the 

bottom of the screen 

Alternativ* A Cost Saving* 
OWu koa Ooaa*»a 

Figur* ». Alternativ* Scr»»n 

At this point you can return to the Summary graph by choosing the Return menu 

item and the Summary option or break out the cost savings further. Other menu choices 

are Edit to edit the graph and Print to print the Operations/Management and Support 

graph. 

C. LEVEL 3-THE COST BREAKOUT SCREEN 

If you are following the DMRD Base or Baseline path and select the Operations 
option from the Cost Breakout menu, a graph similar to Figure 9 is displayed. This graph 
depicts total operations costs broken-out by its six cost dements: Civilian Labor, Military 

Labor, Information Technology, Facilities, Materiel, and Other. If you select the 

Management & Support option from the Cost Breakout menu, these six cost dement 

categories phis General Installation Support and Headquarters Support costs are 
displayed. 

From this levd, you can return to the previous kvds by using the Return menu, 

or you can sdect a life-cycle phase and examine or enter the actual cost data in the data 
sheets You can also examine the total cost data by sdecting the Subtotals menu. The 

values in the subtotal sheet are for viewing only and cannot be changed. 
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Operations Coals Breakout 
Total BMIII»! COW 

Figure 9. Cott Breakout Screen 

If you are following an Alternative path and select the Coit Breakout menu item 

and the Operations option, a graph similar to Figure 10 is displayed. This screen depicts 

operations cost savings broken out by the cost elements. Similarly, if you sclrct the 
Management & Support option, the management and support cost savings are broken 

out. 

Operations Co*t Smttngm Breakout 
ic-P»e—fco—e nil • 

• -i 

» 

I, 
•J . 

i: 
•w * 

Vavl «Ml V«o3 VM< 1*m% VMT* 

Figure 10. Alternativ« Breakout Screen 
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From this screen, you can return to the previous screens by using the Return 

menu, or you can select a life-cycle phase and examine or enter the actual cost data in the 

data sheets Again, you can examine the total cost data b/ cost element by selecting the 

Subtotals menu Other menu choices at this level are Fdit to edit the Cost Breakout 

graph or Print v> print the Cost Breakout graph 

D. LE\TL 4 - THE DATA SHEET SCREEN 

Level 4 is where you enter data. All cost data should be entered in the constant 

dollar format and entered only into the "Temp.xls" file (see Figures 11,12). The first data 

sheet, shown in Figure II, is for the Baseline RDT&E costs. The second data sheet, 

shown in Figure 12, is for RDT&E costs for an Alternative The only difference between 

these screens is that high and low values are entered for an Alternative The values that 

make up ihe Baseline, DMRD Base, and each Alternative are entered in the data sheets. 

Each cell must have a numeric value in it, even if that value is zero The high and low 

entries may have the same alue AH data should be rounded to two decimal places. Once 

the values are entered, the Alieruatives can be processed by the simulation routine from 

the Summary screen. 

HHHHHBMiHBAHBBHHI^BHBiHB^HBBBMSBH 
1  DVWW     |^i^      nviv                                                                                                                                                                           VAV. 
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V*a/1    Vtwt   YMI   Y*ar4   VaarC   V« we 
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Figure 11. Baselin« Data Sheet Scraan 

The Help menu at the Data Sheet level includes information on the cost element 

structure and cost element definitions. 
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APPENDIX A 
RISK ADJUSTMENT CALCULATION 

In order to explicitly account for the risks of any given Alternative, u simulation 
routine has been incorporated into the model The simulation is performed by selecting 
the Simulate menu at Level 1 and choosing one of the Alternatr -ts (Alt A, Alt B, or Alt 

Q. 

The simulation routine works in the following manner: 

Each cost element is specified under the Baseline (B) and under the Alternative 

B ~A 
(A). If the cost is incurred in year t, the discounted cost saving is NPV j- , where 

r is the discount rate. Note that we adopt an "end-of-year" discounting convention, so 
that even savings that accrue in the first year (currently FY 1993) are discounted. The 
savings are summed over all cost elements and «il years. An example is shown below, 
with a discount rate of 10 percent. 

YaLL XaL2 YW3 

Baseline 200 ISO 160 

Alternative     190 ISO 110 

NPV - —* f+—*—-f +-^ f 
Q.+1)1   a+D    a+rr 

 10      30     50 
NPV -  + +  

L10   121   U3 

NPV - 715 

By default, the model employs a real discount rate of 10 percent per year (0.10). 
However, the user may alter this parameter by choosing the Edit Parameters option from 
the Simulate menu at Level 1. Be certain to enter the discount rate as a decimal (Figure 
A-l). 
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Microsoft Excel - SUMCONSTJO.C 
Elle    BMRD But     Baseline   AW ft     AUB    A« C     Simulate    Jflew    firtnt    Help 31 

Summary of Functional AetMty 
Total Annual Costs and RADGF Savings 

RAOCF (Alt A) RAOCF(AJtB) 

YwS 

RADCF(A»0 

. ivinq« High 
Expadad 
Low 

«216 
•196 
1174 

High 
Expected 
Low 

t160 
«139 
9112 

High 
Exoactad 
Low 

$118 
9100 
«80 

Figur« A-1. Edit Parameter* 

Ordinarily, cost dements are tracked for six years. However, the user has the 
option of specifying a "residual value." Under this option, all costs for the sixth year are 

repeated for as many additional years as the user specifies (up to 20 additional years), as 

illustrated below for a residual value of 2. 

NPV 
(L+D i1   (L+rf   a+rr   a+t;    a+rr   a+rr   a+r)7   a+rr 

The cost dements under the Alternative are simulated to reflect risk. In the dtta 
screens, each cost dement is entered as both a "low" value (L) and a "high" value (H). 

These values are chosen so that a cost bdow L occurs only 2.5 percent of the time, and 
similarly for a cost above H. 

The Alternative cost dements are simulated from a lognormal distribution. That 

is, the natural logarithm of cost is assumed to have a normal distribution. The lognormal 
distribution, which applies to the cost dement hsdf, has the property of being skewed to 

the right, so that extreme costs due to programming errors, schedule delays, etc., are 
accommodated. 
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On the logarithmic scale, the mean (denoted m) of the normal distribution is 

estimated as the midpoint of the logs of the high and low values, m~ i-212—2§L We 

also use the fact that 95 percent of a normal distribution lies within ± 2 standard deviations 

(denoted s) of the mean   Hence logH - logL = 4s,  or  s«    og^" og^   and the variance 
4 

v^s^. On the logarithmic scale, the low and high cost inputs may be interpreted as a band 

lying ± 2 standard deviations from the "best guess." 

By default, the Alternative is simulated 100 times. Within each simulation, every 
cost element is drawn from its respective lognormal distribution. Then the discounted 

sums of savings from the Baseline are computed. The result is 100 discounted sums. By 
choosing Edit Parameter! under the Simulate menu, the user may alter the number of 

simulations to any number between 1 and 500 We do not recommend that the number be 

reduced below 100. We recommend that 100 simulations be performed during the early, 

exploratory stages of analysis. However, 100 simulations may still embody considerable 

statistical "noise." Therefore, we recommend that 500 simulations be performed for the 
final analysis. 

The output screens report the mean of the 100 (or more) simulations. To reflect 

the risk of an Alternative, we also report the 2.5 and 97.5 percentiles from the distribution 

of cost differences. The 2.5 percentile is the value that lies above only 2.5 percent of the 
simulated cost differences. This value represents the "worst case." The 97.5 percentile is 

the value that lies above 97.5 percent of the simulated cost differences, or below only 2.5 

percent of them. This value represents the "best case." 
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APPENDIX B 

COST STRUCTURE OUTLINE AND DEFINITIONS 

For ic results of the model to be useful, the cost data must He entered in a 
consistent fashion across all functional weas This involves using a «.ost breakdown 
structure that incorporates the major phases and expense types that are imp •*-.. to life 
cycle costing The first subsection of ehe appendix shows an outline of the cost structure 
Tne second subsection lists detailed definitions for each cost dement. 

COST STRUCTURE 

The cost structure includes three levels of indenture. Each item at the third level 
should be entered by year, and by high and low estimate where appropriate. Functional 

managers may choose to maintain these data in a less aggregated form for their own 

purposes. 

A Operations Costs 

Al. RDT&EPhase 
All Civilian Labor 
Al.2 Military Labor 
Al.3 Information Technology 
Al .4 Facilities 
Al.5 Materiel 
Al 6 Other 

A2. Investment Phase 
A2.1 Civilian Labor 
A2.2 Military Labor 
A2.3 Information Technology 
A2.4 Facilities 
A2.5 Materiel 
A2.6 Other 
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A3   Operational Activities 
A3 1 Civilian Labor 
A3.2 Military Labor 
A3.3 Information Technology 
A3 4 Facilities 
A3.5 Materiel 
A3.6 Other 

A4   DisDosal 
A4.1 civilian Labor 
A4.2 Military Labor 
A4.3 Information Technology 
A4 4 Facilities 
A4.5 Materiel 
A4.6 Other 

A5. Other Unique Phases (as required) 
AS.l Civilian Labor 
A5.2 Military Labor 
A5.3 Information Technology 
A3.4 Facilities 
ASS Materiel 
A5.6 Other 

B. Management & Support Costs 

Bl. RDT&E Phase 
Bl.l Civilian Labor 
Bl 2 Military Labor 
B1.3 Information Technology 
B1.4 Facilities 
Bl 5 Materiel 
Bl.6 Other 
B1.7 General Installation Support (General and 

Administrative) 
B1.8 Headquarters Support 
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B2. Investment Phase 
B2.1  Civilian Labor 
B2.2 Military Labor 
B2.3  Information Technology 
B2 4 Facilities 
B2.5 Materiel 
B2 6 Other 
B2.7 General Installation Support (Genera! =u 

Administrative) 
B2.8 Headquarters Support 

B3. Operational Activities Phase 
B3.1 Civilian Labor 
B3.2 Military Labor 
B3.3 Information Technology 
B3.4 Facilities 
B3 5 Materiel 
B3.6 Other 
B3.7 General Installation Support (General and 

Administrative) 
B3.8 Headquarters Support 

B4. Disposal Phase 
B4.1 Civilian Labor 
B4.2 Military Labor 
B4.3 Information Technology 
B4.4 Facilities 
B4.5 Materiel 
B4.6 Other 
B4.7 General Installation Support (General and 

Adminutrative) 
B4.8 Headquarters Support 

BS. Other Unique Phases (as required) 
BS.l Civilian Labor 
B5.2 Military Labor 
BS.3 Information Technology 
BS.4 Facilities 
BS.S Materiel 
BS.6 Other 
BS.7 General Installation Support (General and 

Administrative) 
BS.8 Headquarters Support 
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COST DEFINITIONS 

This section provides cost definitions for the cost structure shown in section A. 
The taxonomy is summarized here in the Coding Structure sub-section, and further 
explanation is provided in the Coding Detail sub-section. 

Coding Structure 

The first three levels of this structure are required by the model, further detail may 
be of value to the functional areas. 

Position 1:   Primary Subdivision of Costs 

A (Operations Costs) or B (Management and Support) refers largely to the 

distinction bee ween direct (Operations) and indirect (Management & Support) costs 

Position 2:   Phase of Work 

1 (RDT&E), 2 (Investment), 3 (Operational Activities), 4 (Disposal), 5 (Other) 
The phases represent a summary description of the general kinds of activities being 

performed to produce output. The costs of each phase can be funded by several different 
appropriations. 

Position 3:   Major Cust Dements 

Identifies the major types or lands of resources being used to produce output by 

Operations and Management & Support as follows: 

Operations Costs: 1 (Crviliwi Labor), 2 (Military Labor), 3 (Information 

Technology), 4 (Facilities), 5 (Materiel), 6 (Other); 

Management & Support Costs: 1 (Civilian Labor), 2 (Military Labor), 3 

(Information Technology), 4 (Facilities), 5 Materiel), 6 (Other), 7 (General 
Installation Support - General and Administrative), S (Headquarter's Support of 
Installations). 

Positions 4-6: Breakout of Major Cost Elements 

Breakout is provided by category and source of funding (appropriations and 
program elements). 
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2. Coding Detail 

A. Operations C sts Represents costs of essential functional activities that are 
directly related to the primary output(s) of an organizational unit for its intended 
customers 

Al. Research, Development, Test and Evaluation (RDT&E) Phase 
Includes all direct costs involved in research, development, test and evaluation of a 
new system or a major modification for eventual production and use in operational 
activities 

Al.l Civilian labor Includes the total civilian pay cost, both gross 
pay and all personnel benefits (e.g., retirement, health insurance, etc ) for 
all personnel directly involved ("hands on") in producing the primary 
outputs of an organization These costs exclude all personnel costs for 
supervision and management. 

A 1.2 Military labor. Includes the total of all officer and enlisted 
pay, including allowances and retirement, for all personnel directly involved 
("hands on") in producing the primary outputs of an organization. These 
costs exclude all personnel costs for supervision and management. 

Ali Information technology. Represents the cost of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that can be specifically and 
directly identified to a primary output. The costs of assets already 
purchased will only be included when they are already being used or are 
planned to be sold or used on another project. Non-cash charges such as 
depreciation and amortization are excluded. 

A1.4 Faculties. Consists of all costs involved in owning, leasing 
and operating a facility that can be directly and solely identified to a 
specific primary output. It would include costs for construction (including 
modification) if purchased, leasing costs if rented, appropriate utility 
charges, and repair and maintenance services (including land-related). The 
costs of assets already purchased wiD only be included when they are 
already being used or are planned to be sold or used on another project. 
Non-cash charges such as depreciation are excluded. 

A1.5 Materiel. Includes all costs for purchases of office furniture, 
equipment (non-computer), supplies, including printing, and postage that 
can be directly identified to a primary output. The costs of assets already 
purchased win only be included when they are already being used or are 
planned to be told or used on another project. Non-cash charges such as 
depreciation are excluded. 

A1.6 Other. AD other costs that can be specifically identified to a 
primary output such as project travel, specific job-related technical training, 
and transportation costs that are not coveted by any of the other dements. 
All non-cash charges such u depreciation and amortization are excluded. 
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A2. Investment Phase. Includes all direct costs associated with the initial 
and new purchase of capital assets (real property and equipment) and non- 
recurring installation and start-up costs. The costs of assets already purchased will 
only be included when they are already being used or arc planned to be sold or 
used on another project 

A2.1 Civilian labor. Includes the total civilian pay cost, both gross 
pay and all personnel benefits (e.g., retirement, hea'th insurance, etc.) for 
all personnel directly involved ("hands on') in producing the primary 
outputs of an organization These costs exclude all personnel co^r *-<• 
supervision and management. 

A2.2 Military labor. Includes the total of all offic and enlisted 
pay, including allowances and retirement, for all personnel ectl\ involved 
("hands on") in producing the primary outputs of an r yinization. These 
costs exclude all personnel costs for supervision end   management 

A23 Information technology. Reprr .»ts the cost of hardware 
(including peripheral equipment), software. - a related telecommunications 
equipment purchased from commercial .zees that can be specifically and 
directly identü 2d to a primary ^A. The costs of assets already 
purchased will only be included .nen they are already being used or are 
planned to be sold or used on another project. Non-cash charges such as 
depreciation and amortization are excluded. 

A2.4 Facilities. Consults of all costs involved in owning, leasing, 
and operating a facility that can be directly and solely identified to a 
specific primary output. It would include costs for construction (including 
modification) if purchased, leasing costs if rented, appropriate utility 
ch^ges, and repair and maintenance services (including land-related). The 
costs of assets already purchased will only be included when they are 
already being used or are planned to be sold or used on another project. 
Non-cash charges such as depreciation are excluded. 

AX5 Materiel. Includes all costs for purchases of office furniture, 
equipment (non-computer), supplies, including printing, and postage tha* 
can be directly identified to a primary output. The costs of assets already 
purchased will only be included when they are already being used or are 
planned to be sold or used on another project. Non-cash charges such as 
depreciation are excluded. 

A2.6 Other. All other costs that can be specifically identified to a 
primary output such as project travel, specific job-related technical training, 
and transportation costs that are nut covered by any of the otlier elements. 
All non-cash charges such as depreciation and aror rtirttion are excluded. 

A3. Operational Activities Phase. Represents the recurring costs that can 
be directly identified to routinely producing primary fimctional outputs 

Reproduced from 
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A3.1 Civilian Labor. Includes the total civilian pay cost, both 
gross pay and all personnel benefits (e.g., retirement, health insurance, etc ) 
for all personnel directly involved ("hands on") in producing the primary 
outputs of an organization. These costs exclude all personnel costs for 
supervision and management. 

A3.2 Military Labor Includes the total of all officer and enlisted 
pay, including allowances and retirement, for all personnel directly involved 
("hands on") in producing th« primary outputs of an organization. These 
costs exclude all personnel costs for supervision and management. 

A3J Infori.iation Technology. Represents the cost of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that can be specifically and 
directly identified to a primary output. This includes all maintenance and 
repair, minor modifications, and all replacement Hems (excluding initial 
purer se). The costs of assets already purchased will only be included 
when they are already being used or are plumed to be sold or used on 
another project. Nou-cash charges such us depreciation and amortization 
are excluded 

A3.4 Facilities. Consists of all costs involved in owning, leasing 
and operating a facility that can be directly and solely identified to a 
specific primary output. It would include costs for construction (including 
modification) if purchased, leasing coats if rented, appropriate utility 
charges, ant. repair and maintenance services (including land-related). The 
costs of assets already purchased wfll only be included when they are 
already being used or are planned to be sold or used on anoirer project. 
Non-cash charges such as depreciation are excluded. 

A3.5 Materiel Includes all costs for purchases of office furniture, 
equipment (non-computer), supplies, including printing, and postage that 
can be directly identified to a primary output. The costs of assets already 
purchased will only be included when they are already being used or are 
planned to be sold or used on another project. Non-cash charges such as 
depredation are excluded. 

A3.4 Other. AD other costs that can be specifically identified to a 
primary output such as project travel, specific job-related techiucri trainin«, 
and transportation costs that are not covered by any of the other elements. 
All non-cash charges such as depreciation and amortization are excluded. 

A4. Disposal Phase.  Represents the direct costs of disposing assets less 
the estimated salvage value or sales price. 

A4.1 Civilian labor. Includes the total civilian pay cost, both gross 
pay and aO personnel benefits (e.g., retirement, heahh insurance, etc.) for 
all personnel directly involved ("hands on") in producing the primary 
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Outputs cf an organization    These costs exclude all personnel costs for 
supervision and management. 

A4.2 Military labor. Includes the i*. v of all ofE^er and enlisted 
pay, including allowances and retirement, for all personnel directly involved 
("hands on") in producing the pr^wy oi",:ts of «n organization These 
costs exclude J! personnel costs for supervision and management 

A4J Information Technology. Represents the cos* of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that can be specifically and 
directly identified to <• prit.jary output. The costs of assets already 
purchased will only be included when they are already being used or arc 
planned to be sold or used on another project. Non-cash charges such as 
depreciation and amortization are excluded. 

A4.4 Facilities. Consists of all costs involved in owning, leasing 
and operating a facility that can be directly and solely identified to a 
specific primary output. It would include costs for construction (including 
modification) if purchased, leasing costs if rented, appropriate utility 
charges, and repair and maintenance services (including land-related). The 
costs of assets already purchased will only be included when they are 
already being used or are planned to be sold or used on another project. 
Non-cash charges such as depreciation are excluded. 

A4.5 Materiel. Includes all costs for purchases of office furniture, 
equipment (non-computer), supplies, including printing, and postage that 
can be directly identified to a primary output. The costs of assets already 
purchased win only be included when they are already being used or are 
planned to be sold or used on another project. Non-cash charges such as 
depreciation are excluded. 

A4.6 Other. All other direct costs that can be specifically 
identified to a primary output such as project travel, specific job-related 
technical training, and transportation costs that are not covered by any of 
the other elements. All non-cash charges such as depreciation and 
amortization are excluded. 

A5. Other Unique Phases (as required) Reserved for special or unique 
types of activities that do not generally fit any of the other phases and is of such 
significance to warrant separate accounting. 

B. Management ft Support Costs Consists of «II costs other than operational 
costs. Such costs ve considered to be indirectly related to the primary output because 
they cannot be easily or econornicauy identified to an output and typically support more 
than one primary output. 
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Bl      Research,  Development,  Test  und Evaluation  (RDT&E)  Phase 
Includes all indirect costs involved in research, development, test and evaluation of 
a new system or  a major modification for eventual  production and use in 
operational activities. 

ßl.l Civilian labor. Consists of the total civilian pay costs, both 
gross pay and benefits, for all management, supervision and administration 
for ihe functional unit. Represents supervision and management within the 
functional unit and the cost of all administrative activities (e.g., secretarial, 
general administration, etc.). Also includes the indirect costs for all 
activities performed within the basic organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particular functional unit 

B1.2 Military labor Consists of the pay, including allowances and 
retirement, for all management, supervision and administration for the 
functional unit. Represents supervision and management within the 
functional unit and the cost of all administrative activities (e.g., secretarial, 
general administration, etc.). Also includes the indirect costs for all 
activities performed within the basic organization (which the functional unit 
is a part of) at all levels (bot installation and headquarters) to support the 
primary outputs of the particular functional unit 

BU Information Technology. Represents the cost of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that cannot be specifically 
and directly identified to a primary output. Such costs are incurred within 
the functional unit or the basic organization (which the functional unit is a 
part of) at all levels (both installation and headquarters). Normally these 
resources support two or more primary outputs and cannot be traced easily 
or economically to primary outputs. The costs of assets already purchased 
will OIL, be included when they are already being used or are planned to be 
sold or used on another project. Non-cash charges such as depreciation 
and amortization are excluded. 

B1.4 Facilities. Consists of all indirect costs involved in owning, 
leasing and operating a facility that cannot be directly and solely identified 
to a specific primary output. Such costs are incurred within the functional 
unit or the basic organization (which the functional unh is a part of) at all 
levels (both installation and headquarters). Normally these resources 
support two or more primary outputs and cannot be traced easily or 
economically to primary outputs. It would include costs for construction 
(including modification) if purchased, leasing costs if rented, appropriate 
utility charges, and repair and maintenance services (including land- 
related) The costs of assets already purchased will only be included when 
they are Already being used or are planned to be sold or used on another 
project.  Non-cash charges such as depreciation are excluded. 

B-9 



FI 5 Maieriel Includes all indirect costs for purchases of office 
furniture, equipment (non-computer), supplies including, printing, and 
postage that cannot be directly identified to a primary output. Such costs 
are incutrtJ within the functional unit or the basic organization (which the 
functional unit is r oart of) at all levels (both installation and headquarters) 
Normally tht it resources support two or more primary outputs and cannot 
be traced easily or economically to primary cutputs The costs of assets 
«treaty purchased will only be included when they are already being used 
or are planned to be sold or used on another project. Non-cash charges 
such as depreciation are excluded. 

Bl.o Other, includes all tmiircci costs other than labor which 
support primary -Mtputs su '•> as general training, transportation, and travel. 
Such costs are incurred within the functional unit or the basic organization 
at all levels (both installation and headquarters) and cannot be readily 
classified within any of the other five cost elements. Non-cash charges 
such 13 depreciation are excluded. 

B1.7 General Installation Support (General and Administrative). 
Includes all indirect costs for activities performed by installation 
organizations (other than the basic organization of the functional unit) in 
support of the functional unit. It includes all the major cost elements 
excluding information technology i.e. labor, facilities, material, and other. 
Non-cash charges such as depreciation and amortization are excluded. 

B1.8 Headquarters Support of Installations. Represents the 
indirect costs of major and intermediate commands. Service headquarters, 
Office of Secretary of Defense, Joint Chiefs of Staff) other Defense 
agencies, and functional headquarters at both the Service and OSD levels. 

B2. Investment Phase. Includes all indirect costs associated with the initial 
and new purchase of capital assets (real property and equipment) and non- 
recurring installation and start-up costs. The cosu of assets already purchased will 
only be included when they are already being u«ed or are planned to be sold or 
used on another project. 

B2.1 Civilian labor. Consists of the total civilian pay costs, both 
gross pay and benefits, for all management, supervision and administration 
for the functional unit. Represents supervision and management within the 
functional unit and the cost of all ujtmmscnative activities (e.g., secretarial, 
general administration, etc.). Also includes the indirect costs for all 
activities performed within the bask organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particular functional unit. 

Btl Military labor. Consists of the pay, including allowances and 
retirement, for all management, supervision and administration for the 
functional unit. Represents supervision and management within the 
functional unit and the cost of aD administrative activities (e.g., secretarial, 
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general administration, etc.). Also includes the indirect costs for all 
activities performed within the basic organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particular functional unit. 

B2.3 Information Technology. Represents the cost of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that cannot be specifically 
and directly identified to a primary output. Such costs are incurred within 
the functional unit or the basic organization (which the functional unit is a 
part of) at all levels (both installation and headquarters). Normally these 
resources support two or more primary outputs and cannot be traced easily 
or economically to primary outputs. The costs of assets already purchased 
will only be included when they are already being used or are planned to be 
sold or used on another project. Non-cash charges such as depreciation 
and amortization are excluded. 

B2.4 Facilities. Consists of all indirect costs involved in owning, 
leasing and operating a facility that cannot be directly and solely identified 
to a specific primary output. Such costs are incurred within the functional 
unit or the basic organization (which the functional unit is a part of) at all 
levels (both installation and headquarters). Normally these resources 
support two or more primary outputs and cannot be traced easily or 
economically to primary outputs. It would include costs for construction 
(including modification) if purchased, leasing costs if rented, appropriate 
utility charges, and repair and maintenance services ("including land- 
related). The costs of assets already purchased will only be included when 
they are already being used or are planned to be sold or used on another 
project.  Non-cash charges such as depreciation are excluded. 

Bl£ Materiel. Includes all indirect costs fix purchases of office 
furniture, equipment (non-computer), supplies including, printing, and 
postage that cannot be directly identified to a primary output. Such costs 
are incurred within the functional unit or the basic organization (which the 
functional unit is a part of) at all levels (both installation and headquarters). 
Normally these resources support two or more primary outputs and cannot 
be traced easily or economically to primary outputs. The costs of assets 
already purchased win only be included when they are already being used 
or are planned to be sold or used on another project. Non-cash charges 
such ax denreciation are excluded. 

B2.6 Other. Includes all indirect costs other than labor which 
support primary outputs such as general training, transportation, and travel. 
Such costs are incuTed within the functional unit or the basic organization 
at aD levels (both installation and headquarters) and cannot be readily 
classified within any of the other five cost dements. Non-cash charges 
such as depreciation are excluded. 
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B2.7 General installation Support (General ard Administrative) 
Includes all indirect costs for activities performed by installation 
organizations (other than the basic organization of the functional unit) in 
support of the functional unit. It includes all the major cost elements 
excluding inloi .ration technology i.e labor, facilities, materiel, and other 
Non-cash charges such as depreciation and amortization are excluded 

B2.8 Headquarters Support of Installations. Represents the 
indirect costs of major and intermediate commands. Service headquarters, 
Office of Secretary of Defense, Joint Chiefs of Staffs oth«r Defense 
agencies, and functional headquarters at both the Service and OSD levels. 

B3.   Operational Activities.   Represents the recurring indirect costs that 
can be directly identified to routinely producing primary functional outputs 

B3.1 Civilian labor. Consists of the total civilian pay costs, be Xh 
gross pay and benefits, for ail management, supervision and administration 
for the functional unit. Represents supervision and management within the 
functional unit and the cost of all administrative activities (e.g., secretarial, 
general administration, etc.). Also includes the indirect costs for all 
activities performed within the b*sic organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particular functional unit. 

B3.2 Military labor. Consists of the pay, including allowances and 
retirement, for all management, supervision and administration for the 
functional unit. Represents supervision and management within the 
functional unit and the cost of all administrative activities (e.g., secretarial, 
general administration, etc.). Also includes the indirect costs for all 
activities performed within the basic organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particular functional unit. 

B3.3 Information Technology. Represents the cost of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that cannot be specifically 
and directly identified to a primary output. This includes all maintenance 
and repair, minor modifications and aO replacement items (excluding initial 
purchase). Such costs are incurred withm the functional unit or the basic 
organization (which the functional unh is a part of) at aD levels (both 
installation and headquarters). Normally these resources support two or 
more primary outputs and cannot be traced easfly or economically to 
primary outputs. The costs of assets already purchased will only be 
included when they are already being used or are planned to be sold or 
used on another project. Non-cash charges such as depreciation and 
amortization are excluded. 

B3.4 Faculties. Consists of aO indirect costs involved in owning, 
Vszag and operating a faculty that cannot be directly and sc4dy identified 
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to a specific primary output. Such costs arc incurred within the functional 
unit or the basic organization (which the functional unit is a part of) at all 
levels (both installation and headquarters). Normally these resources 
support two or more primary outputs and cannot be traced easily or 
economically to primary outputs. It would include costs for construction 
(including modification) if purchased, leasing costs if rented, appropriate 
utility charges, and repair and maintenance services (including lanH 
related). The costs of assets already purchased will only be included when 
they are already being used or are planned to be sold or used on another 
project.  Non-cash charges such as depreciation are excluded. 

B3.S Materiel. Includes all indirect costs for purchases of office 
furniture, equipment (non-computer), supplies including, printing, and 
postage that cannot be directly identified to a primary output. Such costs 
are incurred within the functional unit or the basic organization (which the 
functional unit is a part of) at all levels (both installation and headquarters). 
Normally these resources support two or more primary outputs and cannot 
be traced easily or economically to primary outputs. The costs of assets 
already purchased will only be included when they are already being used 
or are planned to be sold or used on another project. Non-cash charges 
such as depreciation are excluded. 

B3.6 Other. Includes all indirect costs other than labor which 
support primary outputs such as general training, transportation, and travel. 
Such costs are incurred within the functional unit or the basic organization 
at all levels (both installation and headquarters) and cannot be readily 
classified within «ny of the other five cost elements. Non-cash charges 
such as depreciation are excluded. 

B3.7 General Installation Support (General and Administrative). 
Includes all indirect coats for activities performed by installation 
organizations (other than the basic organization of the functional unit) in 
support of the functional unit. It includes all die major cost elements 
excluding information technology i.e. labor, facilities, materiel, and other. 
Non-cash charges such as depreciation and amortization are excluded. 

B3.S Headquarters Support of Installations. Represents the 
indirect costs of major and imermediate commands, Service headquarters, 
Office of Secretary of Defense, Joint Chiefs of Staff, other Defense 
agencies, and functional headquarters at both the Service and OSD levels. 

B4. Disposal Phase. Represents the indirect costs of disposing assets less 
the estimated salvage value or sales price. 

B4.1 Civilian labor. Consists of the total civilian pay costs, both 
gross pay and benefits, for all management, supervision and administration 
for the functional unit. Represents supervision and management within the 
functional unit and the coat of aO administrative activities (e.g., secretarial, 
general administration, etc.).   Also includes the indirect costs for all 
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activities performed within the basic organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particul&r functional unit. 

B4.2 Military labor. Consists of the pay, including allowances and 
retirement, for all management, supervision and administration for the 
functional unit. Represents supervision and management within the 
functional unit and the cost of all administrative activities (e.g., «ecietarial, 
general administration, etc.). Also includes the indirect costs for all 
activities performed within the basic organization (which the functional unit 
is a part of) at all levels (both installation and headquarters) to support the 
primary outputs of the particular functional unit. 

B4.3 Information Technology. Represents the cost of hardware 
(including peripheral equipment), software, and related telecommunications 
equipment purchased from commercial sources that cannot be specifically 
and directly identified to a primary output. Such costs are incurred wit1 n 

the functional unit or the basic organization (which the functional uni* a 
part of) at all levels (both installation and headquarters). Normally w.ese 
resources support two or more primary outputs and cannot be traced easily 
or economically to primary outputs. The costs of assets already purchased 
will only be included when they are already being used or are planned to be 
sold or used on another project. Non-cash charges such as depreciation 
and amortization are excluded. 

B4.4 Facilities. Consists of all indirect costs involved in owning, 
leasing cad operating a facility that cannot be directly and solely identified 
to a specific primary output. Such costs are incurred within the functional 
unit or the basic organization (which the functional unit is a part of) at all 
levels (both installation and headquarters). Normally these resources 
support two or more primary outputs and cannot be traced easily or 
economically to primary outputs. It would include costs for construction 
(including modification) if purchased, leasing costs if rented, appropriate 
utility charges, and repair and maintenance services (mcluding land 
related). The costs of assets already purchased will only be included when 
they are already being used or are planned to be sold or used on another 
project.  Non-cash charges such as depredation are excluded. 

B4.5 Materiel. Includes all indirect costs for purchases of office 
furniture, equipment (non-computer), supplies including, printing, and 
postage that cannot be directly tfentified to a primary output. Such costs 
are incurred within the functional unit or the bask organization (which the 
functional unit is a part of) at all levels (both installation and headquarters). 
Normally these resources support two or more primary outputs and cannot 
be traced easily or economically to primary outputs. The costs of assets 
already purchased will only be included when they are already being used 
or are planned to be sold or used on another project. Non-cash charges 
such as depreciation are excluded. 
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B4.6 Other. Includes all indirect costs other than labor which 
support primary outputs such as general training, transportation, and travel. 
Such costs are incurred within the functional unit or the basic organization 
at all levels (both installation and headquarters) and cannot be readily 
classified within any of the other five cost elements. Non-cash charges 
such as depreciation are excluded. 

B4.7 General Installation Support (General and Aaministrative) 
Includes all indirect costs for activities performed by installation 
organizations (other than the basic organization of the functional unit) in 
support of the functional unit. It includes all the major cost elements 
excluding information technology i.e. labor, facilities, materiel, and other. 
Non-cash charges such as depreciation and amortization are excluded. 

B4.S Headquarters Support of Installations. Represents the 
indirect costs of major and intermediate commands, Service headquarters, 
Office of Secretary of Defenre, Joint Chiefs of Staff, other Defense 
agencies, and functional headquarters at both the Service and OSD levels. 

BS. Other Unique Phases (as required). Reserved for special or unique 
types of activities that do not generally fit any of the other phases and is of such 
significance to warrant separate accounting. 
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ABBREVIATIONS 

DDI Director of DoD Information 
DMR Detense Management Review 
DoD Department of Defense 
FEAM Functional E-onomic Analysis Model 
IDA Institute for Defense Analyses 
RADCF RisJc-Adjusted, Discounted Cash Flow 
RDT&E Research, Development, Test and Evaluation 
TO A Total Obligation^ Authority 
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ERRATA 'AO-ti/7/ M% 

MEMORANDUM FOR DEFENSE TECHNICAL INFORMATION CENTER 
ATTN:  DATA BASE SUPPORT, WILLIAM BUSH 

SUBJECT:  Corporate Information Management Bibliography 
Limitations 

We have reviewed the document.3 under our purview and 
currently limited for distribution through DTIC. We have 
determine«:1, that the limitations on the following documents 
can be changed to Catagory A, Approved for Public Release, 
Distribution Unlimited: 

ACCESSION NUMBER: M200225 
B171442 
M200146 
M200149 

rM20Q14fiT,\ 
M200107L 
B164404 
B166990L 
M200140 

rv©»H Vio. a.Qto*. 

The following documents will remain under the current 
Category E distribution limitations: 

ACCESSION NUMBER: B174459L 
M200175L 
M200176L 

^L/Michael S. Yoemans 
Director, Functional Process Improvement 

cc:  Frank FitzMaurice, DTIC ERRATA -RÖß/V/Mb 

Q 


	BLANK PAGE.pdf
	BLANK PAGE

	###2-GENERAL DISCLAIMER.pdf
	GENERAL DISCLAIMER

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER

	BLANK PAGE.pdf
	BLANK PAGE

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER

	BLANK PAGE.pdf
	BLANK PAGE

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER

	BLANK PAGE.pdf
	BLANK PAGE

	###IntentionallyLeftBlank.pdf
	GENERAL DISCLAIMER


